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USE AND DISTRIBUTION NOTICE

e Santa Clara County RACES authorization is granted to use and
duplicate this material as-is as long as this page and the
copyright notices on each page are included, acknowledging
Santa Clara County ARES/RACES as the holder of the
copyright.

e Permission is granted to adapt this presentation to your
needs as long as you acknowledge our copyright and include a
note similar to "adapted with permission from Santa Clara
County ARES/RACES”

e For additional information on training or any of our programs
send an email to: info@scc-ares-races.org
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HOUSEKEEPING
e Introductions 2019
e Pen/pencil & paper FOLLOW/NC
e Cell phones INSTRUCTION‘
¢ Side conversations
* Questions
WHAT WAS
e Corrected Handouts LEARN HOW BALER =
TO READ AND
" Breaks ot
e Restrooms (code: 9033) AL
e In case of emergency
¢ No wandering or exploring
other areas of the building.
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Overview: Packet Classes

Packet Type Ill, Part A Packet Type Ill, Part B

* Role of the Packet Operator Packet Operations

* Packet Network Overview Diagnosing Setup Problems
¢ Packet Network Components Selecting a BBS

* Packet Station HW & SW Creating Messages

.

.

Accessing the Network Event Documentation
Standard Workflow Productivity Hints
Exercises

Packet Type Ill, Part A+
* Packet Operations Self-Paced
Exercise workbook

Packet Type Il: Advanced Techniques, such as County EOC Packet
Station Setup & Operations, Operating without Outpost.

Learning Objectives

At the end of this class, you should be able to:

¢ Understand the setup and operation of the county EOC radio
room packet station

e Set up and use a terminal program to access a BBS

e Without Outpost...
— Connect to a JNOS BBS
— Send and receive plain text messages with BBS commands
— Send and receive PackltForms with BBS commands

A Note on receiving Class Credit

To get credit for this class, there are 3 things that you
need to do:

1. Attend the classroom session.

2. Complete the evaluation by the Saturday, one week
after the class. See the instructions at the end of
this material.

3. Complete the exercise by the Saturday, one week
after the class.

© Copyright 2011-2023 Santa Clara County ARES®/RACES. All rights reserved. 2
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Fictitious Examples

e We use fictitious call signs in this presentation to
avoid SPAM

e W6XRL4: Herman Munster

e XNDEOC: City of Xanadu Emergency Operations

Center
7
What about Xanadu?

e Xanadu received lasting fame
in the western world thanks
to the Venetian explorer Marco Polo’s
description of it in his celebrated book Travels (c. 1298).

e Distant and mysteriously lost Xanadu, thus, came to represent a
place of mystery, splendid luxury and easy living.

* Fortunately, you get to visit Xanadu only during Packet classes and
Packet exercises.

* Only use an XNDxxx tactical call that has been specifically assigned
to you for an exercise or training event and then only for the
duration of that event, including any homework follow-up.

* PLEASE NEVER USE XNDxxx tactical calls during any other time.
Instead, use one of your City’s extra tactical calls for practice (with
your EC’s permission, of course).

R E: 8
8
How to process high volume traffic efficiently
9
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Packet Net Operations at County EOC

e County message handling can be non-stop action
¢ Have separate send & receive stations

e Learn to use the automation
— Automated polling every 5 minutes by Telnet
— Automated ICS 309 Logging

¢ Watch message handling order

¢ Move the messages to the Traffic Manager as quickly
as possible

¢ Balance outgoing and incoming traffic
¢ Follow the SCCo Radio Room packet procedures

10

SCCo Packet Net

Reference Binder 00 NoT REMOVE

REPLACE WHEN FINISHED

What’s inside

¢ There is a “standardized” binder CAUNTYOF SANIA
for every position in the SCC CLARA

EOC, including each position in
the RACES radio room.

RACES UNIT
¢ The Packet Net binder contains
the material from the previous
binder, with updates in PACKET NET
progress. Position Reference Binder

¢ General content includes:

EMERGENCY OPERATIONS CENTER
POISITION REFERENCE MATLRIAL

— activation and operation
- end-of-shift and demobilization
— Packet-specific activities

11

County Radio Room Traffic Routing

Radio Room Shift Supervisor

Msg Traffic To Net Boxes

Net Teams
Runner Trays Manager

Message Net

Packet Net

... Other Nets

TO Verify Message

P:':;UP H—> Radio ~—> Prioritize
8 Room Route

Packet

From Net Boxes
5 Verify
oel o o (wessage et )
sver |€—— Prioritize Message Net
& Log EOC
Route Packet Net
... Other Nets

* For small, low traffic events, radio room supervisor may also
perform the traffic manager role

rta Clara County ARESBIRACES. Al rights reserve 12
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Prioritizing Packet Traffic

10/19/2023

Scribe/

Operator
Operator P

Prioritize Prioritize
To Message NetBox — vs. other | vs. On
- Outgoing Incoming The
Traffic Air

Manager Prioritize Prioritize

From Message Net Box <€— vs. other €—— vs.
Incoming Outgoing

Internal notes E a

and messages

e Operator prioritizes message in Outpost

— Holds incoming for high priority outgoing and vice versa
* Scribe/Operator prioritizes & logs message in to & out from the team
— Maintains prioritized incoming and outgoing message bins

¢ Separate Send & Receive stations facilitate processing

. e 13
Santa Clara Couny ARES (i s

13

County EOC Packet Station Overview

LAN / Fiber / Wi-Fi
I | I

g

PC1 PC2 ==
- . \ SCCo
i Automatic R - .

Transmit u (;T:clecssﬁcgewe Printer  Backup Printer RACES
( ) Network

(1)
A Rooftop W1XSC-1
A\ Antenna W2XSC-1
e One PC normally configured for transmit only W3XSC-1

W4XSC-1

e One PC normally configured for (automated) receive

e Either PC can perform both tasks
e Both PCs have a primary and backup printer defined
e Backup TNC/radio can be switched to either PC

14

OUTPOST

INTERACTING WITH THE BBS

WITHOUT OUTPOST

15
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Packet Operator Type Il 10/19/2023

Its all about control with Text Commands

e Simple text commands control the TNC
— MYCALL callsign = set the TNC’s Mycall command to your callsign
— CD software = set Carrier Detect mode to software
— Ccallsign = Connect to station callsign (ax.25 address)
¢ Simple text commands control the BBS mailbox
— SP address = Send a Private message to an address
— LA = List All messages in this area (mailbox)
— R n=Read message number n

e Qutpost simply automates the process of typing the
commands to the TNC (to connect) and then to the BBS
(to send/receive messages)
— Watch the Outpost session window to see what it’s doing
— View the Outpost transaction log later to see what it did
* Actions > View Outpost Data Directories > logs > transactionYYMMDD.log

. 16
i cights reserved
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Sidebar: Outpost Logs

From Outpost: Actions > View Outpost data directory > logs

8 session2110150g - Notepad

Fle Edit Format View Help

15-0ct 09:34:40:
3019

Outpost/Opsessn v3.5.0 co: THC Session #

15-0ct 09:34140: Using Call Sign KNGPE
sing TNC setup XSC_Kantronics_KPC3-Plus cod
sing BBS setup XSC_WIXSC-1 €an't DISCOMMECT, A Link state is: DISCOMMECTED
nccheck: THC is ok cmd:h
ncInit: Complete as KNGPE BEACON  EVERY O (disabled)
+ BbsConnect: Connected to WIXSC-1 as user <cnd:Echa on
ECHO was O
: BbsConnect: B85 is INOS codimy KNGPE
i plien SEL, — P
= S——— =
STREAMEV Was OFF
cmd:STREAMSH $00
STREAMSH Was $7C (1)
cmdconnect WIXSC-1
: BbsDisconnect: BBS Session closed cmdi*** COMECTED to KIXSC-1
[IM05-2. 0k 2. X5C . 4-BIFHIMS |
You have 0 messages.
(70) »
A XSCPERN
Xscperm: G messages - 6 new.
(1) >

& T SenaRecens Session window 15333
r
I~ L3 SenaRacens dagnostc race
™ L Main program 6iagnosies race (restan Outpost1s 3ppiy)

FYI...Log Settings has L1 selected by default
Optional: select L2 for additional info

L2 SendRecens Interface data race

17

Everything Can Be Done Manually

e Why would | want to/need to?

— Outpost is not installed or installed incorrectly; no administrative
access to PC

Browse the BBS to read bulletins

— Gain deeper understanding of how packet radio works

— Perform clean up or diagnostic activities on your setup or to maintain
the BBS

e Allyou need is a terminal emulator program
— Suggested: PuTTY (free download) https://www.putty.org/
...or just do an Internet search for “PuTTY”
— But any terminal emulator will do ...

¢ The following examples will use PuTTY
[— Select and copy: highlight/select (not <ctrl>C) ]

— Paste: Right-click (not <ctrl>V)

23 Santa Ciara County ARESEIRACES. Al fght

18
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Summary of Steps to be Discussed

¢ What you need to know to operate without Outpost
e Setting up PuTTY for BBS access (serial)
* The connection basics
— Start of shift: Configure optimized TNC settings
— Per session: Using you FCC call sign, -OR-
— Per session: Using a tactical call sign (plus your FCC call sign)
— End of shift: Restore default TNC settings
¢ Managing Messages on JNOS
— Access user and bulletin areas (mailboxes)
— Read a message
— Send a message
Reading notices and bulletins on JNOS
Working with PackltForms

19

What you need to know
Operations without Outpost

Connect Parameters

TNC Standard Settings and Manual Workflow
TNC User Commands

TNC Init Settings

BBS User Commands

BBS Init Settings

oV A WwN e

20

1. Three Connect Parameters
Operations without Outpost... need to know

o Call Sign or Tactical Call of the user
example : W6XRL4
XNDEOC

e TNC Comm Port Settings
example : COM3,9600,8,N, 1
COM?5,9600,7,E,1

e BBS Connect Name
example : W1XSC-1
W3XSC-1

21
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2. TNC Standard Settings

Operations without Outpost ... needto know

e SCCo RACES determined the optimum TNC parameters for our
BBS system that significantly improves message traffic
throughput.

e Document contains parameters for both Outpost and
Manual sessions. Details of each parameter are explained.

e See: https://www.scc-ares-races.org/data/packet/index.html >
Application Notes - Standard TNC Parameter Settings

... and specifically the section titled: Standard TNC Settings
for Manual BBS Sessions

22

2. TNC Standard Settings

Operations without Outpost ... need to know

Santa Clara County ARES/RACES R [

Packet BBS Service Standard TNC Parameter Settings for
- somews | Apew Santa Clara County Packet Network

Packst BBS Servica Notices

Overview

Sorvice and Network Info

Packet BES Service Deseription

Appiication Notes.

Conngarsnon ang Ses-am inatocsons

Standard NG Paametr St Rev: 072016

2. Manual Operations

Standard TNC Parameter Settings for
Santa Clara County Packet Network

¢ Complete manual ops info

¢ Workflow

Table of Contents

— Start of Shift

— Each message

— End of Shift 7

¢ TNC-specific Commands

Standard TNC Settings for Manual BBS Session: 13 v
Manual Operations Workflow 13 jj
TNC Commands for Manual Operation: 15

..................... aces g
11 I RES! il righ 24

© Copyright 2011-2023 Santa Clara County ARES®/RACES. All rights reserved. 8
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3. Eight TNC user commands
Operations without Outpost (Kantronics KPC-3+)

1. HELP [command]
When entered alone, lists all available commands. With a command, provides
details on that specific command.
2. MYCALL xxxxxx
Tells the TNC what its’ call sign is.
3. CONNECT calll [viacall2, call3, ... ]
Call1 = Call sign of the station to be connected to. Adding “via call2...” connects to the BBS by
digipeaters.
4. CONVERS
Puts the TNC into Conversational mode. Then, whatever you type is immediately transmitted.
5. <ctrl>c
Puts the TNC into Command Mode. Then, enter TNC commands at the prompt.
. RESTORE DEFAULT
Resets the TNC to the factory default settings; performs the AUTOBAUD routine. Defaults
INTface to NEWUSER. Hard reset can be triggered by temporarily removing the battery.
7. INTFACE [TERM | ...]
When set to TERMinal, the full command set of the TNC is available.
8. XMITLVL [value]
~— Displays or sets the TNC’s transmit drive level

Copyright 2011-2023 Santa iara County ARESEIRACES. Al fghts reserves

10/19/2023

25

4. TNC Init Settings

Operations without Outpost ... needto know

¢ Go to the “Standard TNC Settings for Manual BBS Sessions”
¢ Follow instructions in “Manual Operations Workflow”

¢ Use the “TNC Commands for Manual Operations” appropriate for your
particular TNC

TNC Type Manual Ops: Start of Shift Manual Ops: End of Shift
Kantronics KPC-3+ INTFACE TERMINAL STREAMSW $7C

MONITOR

CD SOFTWARE

NEWMODE ON

RETRY 8
CHECK 30
TXDELAY 40
XFLOW OFF
STREAMEV OFF
STREAMSW $00

Copyright 2011-2023 Santa Ciara Courty ARESEIRACES. Al fghts reserve
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5. Eight BBS user commands

https://scc-ares-races.org > Data Networking > Packet BBS > Reference > INOS BBS Information

Santa Clara County ARES/RACES INOS User Ml - Apeodix A
Home Operatons Data > Packet Trsing and Everts Refrence FAQ. Ocober 2, 2018
APPERDIX A
JNOS Packet BBS Information v -

Overview

WEXSC, WIXSC, WAXSC, WEXSC. and WEXEC.

(134

JNOS User Information

©0F -6118) ::> -
INOS Sysop Information ’

« NOS 20 wab e
oS

Notas
NOS Commands Manal
NOS Donrioads

. INOS st “nsators for
oSy
aro provided.
. nstictons
and rloase notos aro provided
« nos-bbs — TAPR xNOS Moilng List il
S by f
lan Wads, GINRW (PDF -22 1B) -
356 pages, ISBN 1897840002 I
Posted here win
permasion ffo the suthor .
“Tie ' the Gfivive ook on xNOS and  musthave fr any JNOS sysop. The pictre on

o 144

==

opyright 2011-2023 Santa Clara County ARESBIRACES. Al ights
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5. Eight BBS user commands
Operations without Outpost ... needto know

1. HELP[command] or?
When entered alone, generates a summary of available commands. With a
command as a parameter, provides details on that command.
H List = shows all the List command options and what they do
2. LIST
L = by itself will display the headers for all unread messages, if any.
LA = List ALL messages, both read and unread
LM = Lists MY messages addressed to me
L> addr = Lists all messages that have “addr” in the To: field of the message

3. READ #
# = The message number to be displayed.
4. KILL #

# = The message number to be deleted.

5. AREA [ Area_name]
A = Lists all available bulletin areas.
AF = Gives a full listing with descriptions of areas.
A area_name = moves you to that area. Then use the List and Read commands
to view messages.

1t 20112023 Santa Clara County ARESEIRACES. Al figts reserved 28
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5. Eight BBS user commands
Operations without Outpost ... needto know

6. SEND [option] <dest_address>
S[P] = Send Private; example: SP wébxrl4@w5xsc.ampr.org
SB = Send Bulletin; example: SB xsctest
SC=Send Copy; to multiple destination addresses
example: SC wbxrl4@w5xsc.ampr.org
(BBS then prompts with Cc: for all other addresses)

7. BYE
Disconnects from the BBS
8. XM #

displays or sets the page length for viewing messages

29

6. BBS Init Settings; Page Length

Operations without Outpost ... needto know

e The BBS “XM” command displays or sets the page length
— XM = displays the current page length setting
— XM 24 = sets the page length to 24 lines
— XM O =turns off pagination (required when using Outpost)

¢ |f a page length is set, message listings, messages and other
content longer than the page length are paused and a
“More (N=no)?” prompt is shown.
— Press <ENTER> to see the next page; ‘n’ to stop
— Good for reading content on the screen
— Will cause Outpost to hang if not set back to XM 0

e Note: The SCCo Packet Installer includes XM 0 in the BBS Init
Commands for all SCCo BBSs. Outpost will send XM 0 as soon
as it connects to the BBS so message output is never paused.

30

© Copyright 2011-2023 Santa Clara County ARES®/RACES. All rights reserved. 10
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SETTING UP PUTTY FOR BBS ACCESS

31

M Device Manager - a X

Serial Access
Setting up PuTTY

Install and run PuTTY
1. Select the Session tab
2. Select Connection Type = “Serial”

3. Enter the Com Port iR PuTTY Configuration

— Verify with Windows
Device Manager

4. Enter the Speed (baud rate)

o fener Orogn Ossi

doleta a stored session

NOTE: Not all TNCs use 9600,8,N,1
as the configuration. All fields must
match what you actually have set in
your TNC.

32

Set up Session Logging
Setting up PuTTY

5. Next, click on the
Session > Logging tab

2 PuTTY Configuration

6. Set Session Logging to
® All session output

7. Set up a|log file name

NOTE: &H does not work
on Windows

8. ...if the file exists:
®©Always append to the end

Why do logging at all?

« During manual operations, it is
easy to loose track of what is going on.

« Logging creates a history of your manual interactions and a reference if you
ever need to go back and check if you got it all right.

1t 20112023 Sarta Clara County ARESBIRACES. Al ights reserved
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Change PuTTY’s Backspace Key
Setting up PuTTY
9. Next, click on the C
Terminal > Keyboard tab

The PUTTY default does not
send the backspace key code
that the KPC-3+ expects. To
correct this:

y
O Linux Oxtem R6
Ovren Ovrioe- Osco

Appiication keypad setings:

10. Set the Backspace key Tt e
option to Control-H L
Avout Help <

34

Serial Access
Setting up PuTTY

11. Next, click on the... S e
Connection > Serial tab

pions controling local serial nes

12. Set Flow control to
RTS/CTS

E—

35

Name it, Save it, and Open it
Setting up PuTTY

13. Finally, dlick on the...
) T
Session tab ¥

14. Give this session a name
15. Press Save

16. Press Open to open the
connection

NOTE: If you ever change
any setting, remember to
press Save!

36
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THE CONNECTION BASICS

Copyright 2011-2023 Santa iara County ARESEIRACES. Al fghts reserves
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Start of Shift: Configure TNC settings
The connection basics

e TNC settings affect overall performance
— Start with the factory defaults
— Make other settings for efficient use of the BBS
¢ To be absolutely positively certain that all TNC settings are at
the current SCCo standard values, at the TNC prompt,
perform the following:

1. cmd: XMITLVL (for KPC-34) to display

—_— cna:
the existing transmit level <value> v smit1vl
2. cmd: INT Term (justin case) X”émlt md fault
—_ cnd:restore defau
3. cmd: restore default XXXXKKXDXXXXXXXKBXXXXXXXXXXXXXXXXORFE FEDF * FFFE FFFD
R ——— [PRESS (*) TO SET BAUD RATET
4. PRESS (*) TO SET BAUD RATE OO0 OO0XBXO0I0CBEFF” FFDE *FEEE FFFp
y PRESS (*) TO SET BAUD RATE
5. Enter your call sign ENTER YOUR CALLSIGN=> w6xrla
6. cmd: INT Term [KANTRONICS KPC3P VERSION 9.1
—_— (C) COPYRIGHT 2002-2005 BY KANTRONICS INC. ALL RIGHTS RE:
7. cmd: XMITLVL <value> DUPLICATION PROHIBITED WITHOUT PERMISSION OF KANTRONICS.
T o er emd:int term
8. cmd: cd software INTACE was NEWUSER
9. Apply SCCo standard TNC s 208
settings for manual operations jcmd:cd software
jcmd:

RESEIRACES. Al righs reserved
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Start of Shift: Configure TNC settings

The connection basics

¢ Outpost configures the TNC at the start of each Send/Receive session
* For manual operation, you only need to send these commands once, at

the start of your shift
NOTE: Manual Ops commands are slightly different from the Outpost list of
commands.
P
TNC Type Manual Ops: Start of Shift Manual Ops: End of Shift
Kantronics KPC-3+ INTFACE TERMINAL STREAMSW $7C
MONITOR OFF
CD SOFTWARE
NEWMODE ON

8BITCONV ON
BEACON EVERY @
SLOTTIME 10
PERSIST 63
PACLEN 128
MAXFRAME 2
FRACK 6

RETRY 8

CHECK 30
TXDELAY 40
XFLOW OFF
STREAMEV OFF

STREAMSW $00

opyright 2011-2023 Santa Clara County ARESEIRACES. Al rights reserved
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Start of Shift: Configure TNC settings

The connection basics

TNew Text Document txt - Notepad ~ — [a] X
o Create and save a text file with the “Start e e
of Shift” and “End of Shift” TNC ————
commands. MONITOR OFF
CAUTION: Do NOT cut-and-paste EE»;E?EE::E;
directly from the PDF into your terminal BEACON EVERY ©
emulator; it doesn’t always work. PERISTiE,
**Best practice: copy the commands TRFRAE 2
first into a text editor (Notepad), save it, ey
and then copy-and-paste from there into 1Ly
your terminal program. iy
¢ To send the “Start of Shift” TNC STREANSH} 308
commands, --- KPC-3+ End of Shift ---
— Connect to the TNC with PuTTY STREAMSHT7C
— Select and copy the entire “Start of Shift”
command list from the text file Ln g, Col 1t
— Paste it into Putty (right-click) at the TNC
cmd: prompt.

1t 20112023 Santa Clara County ARESEIRACES. Al figts reserved
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During the Shift: FCC Call Sign Session

The connection basics
e Onthe TNC:
1. Set MYCALL to your FCC call sign

2. CONNECT to the BBS / mailbox service

(SSID=1) on W5XSC

(D) cmdimycall wéxrls
| cmd:c wsxsc-1 3. Connected message from TNC
(3)| cmd:*** CONNECTED TO WSXSC-1 e Onthe BBS:
(4| (m08-2.0k.1.xsc. 2-BLFHIMS] . N
(3)| You have 0 messages. 4. BBSsaysitisaJNOS BBS, version is
®) o) > 2.0k.1.xsc.2, with options
(@) » 5. You have no messages
(3] *** pIScoNNECTED 6. BBS Prompt: You are on message #0
()| cma:
7. Youtype “B” (bye) to terminate the
BBS session
The BBS drops the connection
Note: All SCCo BBSs have e Onthe TNC:

. - |
a2 minute Inactivity Timer! 8. Disconnected message from the TNC

9. TNCis ready for the next command

41

FCC Call Sign Session — On the Air

The connection basics

FROM TO

AX25: W6XRL4->W5XSC-1 CONNECT

AX25: W5XSC-1->W6XRL4
DATA: [JNOS-2.0k.l.xsc.2-BIFHIMS$] .You have 0 messages.. (#0) >.

AX25: W6XRL4->W5XSC-1
DATA: b.

AX25: W5XSC-1->W6XRL4 DISCONNECT
Note: Protocol codes have been removed

e FROM and TO addresses of all packets contain legal call signs

e Both stations are meeting the FCC identification requirements
with every packet (more than required)

42

© Copyright 2011-2023 Santa Clara County ARES®/RACES. All rights reserved.
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During the Shift: Tactical Call Sign Session
The connection basics

e OntheTNC:
1. Set MYCALL to your tactical call sign

O oma: 1 end 2. CONNECT to the mailbox service
& z:d;‘gyizxsc’f‘l‘ coc (SSID=1) on W5XSC
(3)| cmd:*** CONNECTED TO WSXSC-1 3. Connected message from TNC
(#)| [INOS-2.0k.1.x5C.2-BIFHIMS] e Onthe BBS:
) Yj‘(; hive 0 messages. 4. BBSsays it is a JNOS BBS, version
g k() ) 2.0k.1.xsc.2, with IHMS$ options
(3)| *** DISCONNECTED 5. You have no messages
(9)| cmd:conv 6.  BBS Prompt: You are on message #0
This is wéxrld 7. Youtype “B” (bye) to terminate the BBS session
end: The BBS drops the connection
e OntheTNC:
Note: All SCCo BBSs have 8. Disconnected message from the TNC
a 2 minute Inactivity Timer! 9. Enter CONVerse mode, and then type in at
least your FCC call sign, press enter to
transmit

10. Enter Cntl-C to return to Command Mode.
TNC is ready for the next command

43

Tactical Call Sign Session — On the Air
The connection basics

FROM TO

AX25: XNDEOC->W5XSC-1 CONNECT

AX25: W5XSC-1->XNDEOC CONNECT
DATA: [JNOS-2.0k.l.xsc.2-B1FHIMS].You have 0 messages. (#0) >.

AX25: XNDEOC->W5XSC-1
DATA: B.

AX25: W5XSC-1->XNDEOC DISCONNECT Note: Protocol codes have been removed

AX25: XNDEOC->CQ
DATA: This is wéxrld. The extra converse mode packet lets you identify
your station XNDEOC as FCC call sign W6XRL4

e XNDEOC is not a legal call sign

e Keep session under 10 minutes and use ID process at the end
of session to satisfy the FCC requirements.

44

End of Shift: Restore TNC settings

The connection basics

TNew Text Document txt - Notepad ~ — [a] X
. File Edit Format View Help
o After the BBS session has e
disconnected, you should be back to I—
the TNC command prompt, usually: ONITOR OFF
CD SOFTWARE
cmd: NEWMODE ON
8BITCONV ON
i i ini BEACON EVERY @
¢ When your shift is finished and BEACOH EVER
before you pack up the gear or turn e
it over to someone else, return the HaERAE 2
TNC to “normal” settings RETRY 8
B CHECK 30
e Cut-and-paste the “End of Shift” TaneLeY 40
Send/Receive settings into PuTTY at STREAMEV OFF

STREAMSW $00
the TNC command prompt

--- KPC-3+ End of Shift ---

[ STREAMSW $7C

Lng, Col 1t

45
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MANAGING MESSAGES WITH
JNOS COMMANDS

Copyright 2011-2023 Santa Clara County ARESBIRACES. Al ighs reserved
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BBS Connect & Login

e Ready to connect to BBS
e Set your call (FCC or tactical) in the TNC for login
cmd: MYCALL W6XRL4 oOr emd: MYCALLXNDEOC
e Connect
emd: C W5XSC-1
cmd @

cmd:mycall wexrl4

. T cmd:c w5xsc-1
INOs gets login info from cmd: *** CONNECTED TO WSXSC-1

MYCALL [INOS-2.8k.1.xsC.2-B1FHIM$]

. You have 1 message - © new.
¢ No login prompt needed (#1) > €
=

right 20112023 Sarta Clara County ARESEIRACES. Al ights reserved
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HELP
JNOS Commands

e Basic commands can be seen with HELP command

Area: woxrld (#1) >
help
For a brief listing of all commands, type ?
To get help for a specific command, enter 'h command’,
The following commands have help descriptions available for them:

alias area bye connect convers download
escape finger help iheard info iproute
jheard kill list mboxuser  nodes nroutes
operator  ping ports query read register
send telnet upload verbose what xpert
zap

Area: wbxrld (#1) >

right 2011-2023 Sarta Clara County ARESBIRACES. Al ights reserved
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HELP

e Help

<command>

JNOS Commands

with the command will give a detailed explanation

10/19/2023

Area: wbxrld (#1) > 2
help area
B Area command will list the msil areas that contain messages
you may read. It also moves you to those areas. You must be in
an area before you can read messages in that area.
A will give a short listing, whereas
AF will give a full listing with descriptions (if available).
A <areaname> moves you to that area.
AF careaname> will give more info about just that area (if available).
AN will show areas that have new mail since you last logged off.
To read messages in one of the areas, type 'A <areanames’
You will then be told how many new, not previously listed messages
there are in this area.
You can send mail to any of the listed areas as 'S areaname’ !
Area: wbxrld (#1) > =
=
Copyright 2011-2023 Santa Clara County ARES®IRACES. All rights reserved. 49
JNOS Commands
e Messages are organized in AREAs
— Your mailbox is an area
— Bulletins: xscperm, xscevent, xsctest are each their own AREA
Alrea] gives a short listing, whereas ...
Area: wéxrld (#1) > 2
a
Current message area is: wéxrld
Available areas are:
wbxrld
Xscperm  xscevent xsctest alllocal
allxsc  allbay  allnca  allca allwusa  allusa
allnoam  allww
Type AF to get description of areas.
AF <name> tells more about that area.
Area: wbxrld (#1) >
I 50
JNOS Commands
AF gives a full listing with descriptions (if available)
Area: wéxrld (#1) > £
T
Available areas are: HOW to
address an
woxrld Your private mail area SCCO NOtiCe
 Santa Clara County Op Area Shared Mailboxes
xscperm Operation, Configuration and other Permanent Info  (To: xscperm)
xscevent Emergency Incident and Public Service Event Info (To: xscevent)
xsctest Test and Training (To: xsctest)
# General Bulletin Areas by Distribution
alllocal  All categories, this BBS only (no distribution) (To: <cat>@local)
allxsc All categories, Santa Clara Co distribution (To: <cat>@xsc)
allbay All categories, SF & Monterey Bay distribution  (To: <cat>@bay)
allnca All categories, Northern California distribution (To: <cat>@nca)
allca All categories, California distribution (To: <cat>@ca) How to
allwusa All categories, Western USA distribution (To: <cat>@uusa)
allusa All categories, USA distribution (To: <cat>@usa) address a
allnoam All categories, North America distribution (To: <cat>@noam) i eneric
allww A1l categories, Worldwide distribution (To: <cat>@a) | ger
bulletin. Note
# <cat> A short (max 6 char) category like “equake”, "flood", "wx", ... "
Area: wbxrld (#1) > the different
format

Copyright 2011-2023 Santa Cira County ARESBIRACES. Al rghts reserve
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AREA Example
JNOS Commands
e Change areas to read SCCo bulletins
— “area xsctest” — changes to the “xsctest” area
— “L” or “LA” — lists or lists all bulletins in that area
— “area <callsign>" — returns you to your own area

cn
cnd: *+* CONNECTED to WIXSC-1
[IN0S-2.0K.1.X5C. 2-B1FHINS ]
You have 2 messages - 2 new.

Area: wexrla (#1) >
area xsctest
You have 1 message - 1 new.
Area: xsctest (#1) >

d} 1
Mail area: xsctest

e L it
St. # TO FROM DATE SIZE SUBJECT
>N 1 xsctest xndeoc Nov 3 2627 Bulletin for Packet Type IT Classro
Area: xsctest (#1) >

|:> i
Area: wexrla (#1) > N
You have 2 messages - 2 new. =

Area: wexrla (#1) >

ES_Al righs reserved

opyright 2011-2023 Santa Clara County ARES
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LIST

JNOS Commands
¢ Displays a list of the messages from the current mailbox
(or "area")

L - by itself will display the headers for all unread messages, if any.

LA - list all messages, read or unread

cmd:c w5Sxsc-1
cnd =+ CONNECTED to WIXSC-1
[INOS-2.0k.1.xsc.2-B1FHIM$]
You have 2 messages - 2 new.

Area: wéxrld (#1) >
=3 1

Mail area: wbcrld Message
Number

2 messages - 2 new

FROM  DATE  SIZE SUBJECT

St.
>N xndeoc  Nov 2 454 XND-123P_R_Jelly Donut Request

N xndeoc Nov 2 443 XND-132P_R_Jelly Donut Delivery No
Area

<[]

Res

£S5 Al ghts

53

READ

JNOS Commands

e R[ead] #

¢ R[ead] <msg_number_or_range>

* To read a specific message, you may either type “R#" or just
the number by itself. RM will display all unread messages,

sequentially.
st. # TO FROM  DATE  SIZE SUBJECT ~
>N 1 wexrld xndeoc Nov 2 454 XND-133P_R_Jelly Donut Request

N2 wexrld xndeoc Nov 2 443 XND-132P_R_Jelly Donut Delivery No

Area: wexrla (#1) >
E> r2

Message #2
Date: Mon, 2 Nov 2017 21:60:@5 PDT
From: xndeoc@usxsc.ampr.org

To: wéxrld
Subject: XND-132P_R_Jelly Donut Delivery Notification

Donut will be delivered by 9AM
Area: wexrld (#2) >

54
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KILL
JNOS Commands
e The KILL command allows you to delete messages from your
mailbox
KI[ill] <message_number>
e At least one message number must be supplied. The message
numbers you can select from can be displayed with the
"L[ist]" command.

e Messages will not disappear until you disconnect and connect
again

55

SEND

JNOS Commands

e The send (S) or send private (SP) command allows you to
enter a message and send it to a user
S[P] <user>@<domain> where
<user> = recipient’s name
<domain> = <bbscall>
<bbscall>.ampr.org
internet domain

e Send an SCCo specific Notice
SB < NoticeArea | <category>@<distribution> >
* SCCo Notices: SB < NoticeArea >
* General purpose bulletins: SB <category>@<distribution>

— As above, but ANY <user> may read the message from the mailbox.
The < NoticeArea > may be...
® xscperm
* xscevent
® xsctest

56

Send a Message from the Keyboard
JNOS Commands

e Connect to the BBS using a terminal program

e Use these BBS commands

— SP <user>@<domain>—Send a message to a user at a specific
domain.

* When prompted, enter an SCCo standard subject
* When prompted, type the body of message
* When done, on the next line, add “/EX” and press [Enter]

1.SP <dest_addr>

. End with /EX or AZ in first column (*A aborts): 2.The subject
This is a wraparound test. 3.The message

fex 4. lex
Msg queued

(#1) >

57
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Send Copy
JNOS Commands
e The send copy command allows you to enter a message and

send it to multiple users
SC <user>@<domain>

¢ Enter the send copy command with one address

* JNOS responds with “Cc:”
— Enter other addresses to receive a copy, separated with commas

(#1) >
5C_W6xrla@nSxsc

‘ Cc: xndeoc@WSxsc, xnd@99@wSXsc , xnde9B@wSxsc
Sunj_&%ec T e

HXM-449P R Multiple addresses
Enter Message. End with /EX or °Z in first column (“A aborts):
This is a test message with multiple addresses.

fex
Msg queued
(#1) >

Copyright 2011-2023 Santa iara County ARESEIRACES. Al fghts reserves
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BYE
JNOS Commands
e When you are all done with the BBS, disconnect from the BBS
Blye]
e On disconnecting
— Outgoing messages will be processed

— Deleted (killed) messages will be removed

il
pon’t Forget!!!
All SCCo BBSs have 2

> ol
2 minute inactwlt; timer!

RESEIRACES. Al righs reserved
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FYI... Manual message basics
Troubleshooting Hint

¢ Knowing how manual packet works will help you troubleshoot problems.

¢ Sending to one destination address:

18 *XND_1021M R Weather H..

File Edit Format View Help

(-D sp <dest address> —————> [sp XNDO14@WIXSC
. Tas XND_1021M_R_Weath Head:
<subject 1ine> —————>XD_10211R Heather Heads up

@ To: Xanadu Station 14
<message line 1> From: County Fire
@® <message line 2> Please double-check the status of all

equipment and confirm its deployment
: readiness.
Weather forecast calls for high winds
< >
message line n and lightening tonight through
/ex sunday.

An official request for this
information will follow.
/ex

1

¢ After the SP command, the BBS prompts
for the subject, then the message.

¢ Once the *ENTIRE* message sequence is created, highlight and copy all
of it and then paste it into PuTTY at the BBS Prompt.

opyright 2011-2023 Santa Clara County ARESEIRACES. Al rights reserved
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FYI... Manual message basics
Troubleshooting Hint

¢ Knowing how manual packet works will help you troubleshoot problems.

¢ Sending to multiple addresses:

/B *XND_1021M R Weather He...

File Edit Format View Help
® sc <dest_address>————5 sc xnpo14gwixsc
@ <other_addresses> > XNDOI5@WIXSC, XNDO71@W1XSC, XNDB3EH1XSC
T . XND_1022M_R_Weather Heads up
@ <subject line> To: Xanadu Stations 14, 15, 71, 83
<message line 1> From: County Fire
Please double-check the status of all
® <message line 2> equipment and confirm its deployment
: readiness.
Weather forecast calls for high winds
<message line n> and lightening tonight through sunday.
@

/ex
An official request for this
\ information will follow.
‘/Ex

After the SC command (Send Copy),
the BBS prompts with a CC: for additional destination addresses.

Once the *ENTIRE* message sequence is created, highlight and copy all
of it and then paste it into PuTTY at the BBS Prompt.

61

FYI... Manual message basics
Saving the message
e There are reasons to save the message before sending it
* You have copy for your records.

* You can save all your messages before sending them.
* Avoids having to re-enter the message if something goes wrong.

e Where you save the message is up to you. But:
« If this is your PC, then save them anywhere where you can find them.
« If this is a shared PC, then create a directory on the C: Drive.
e Forinstance: your directory structure could look like this:
¢ C:\MyMessages
¢ C:\MyMessages\XND-23-1009T (activation number)

e Use the message subject as the name of the file.

BUT... Manual PackitForms will do a lot of this for you!

1 20112023 Sarta Clara County ARESEIRACES. Al igts reserved
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READING BULLETINS ON JNOS

63
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Bulletin Review

:

Bulletins

e Bulletins are messages intended for a
broad audience

e The SCCo BBSs support two types of bulletins:

— Notices are a special type of bulletin specific to Santa Clara County
¢ Only distributed to SCCo BBSs (W*XSC)
* SCCo uses 3 special categories for specific content

— General Bulletins are globally compatible, used for everything else
* User-defined category (e.g.: “equake”, “ARES”) identifies content
* User-defined distribution controls how widely it is distributed (e.g.: “XSC”,

“BAY”, “NCA”, etc.).
e Regardless of the bulletin type, when configured in Outpost,
Outpost will automatically download them

10/19/2023
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SCCo Notice Areas NOTICE

Bulletins
e SCCo ARES/RACES has three special notice categories:

— Xscperm
* Used for notices that do not expire
e examples: standard county procedures
— xscevent
* Notices posted here automatically expire after 8 days

* examples: Drills, public service events, incidents, other
activations

— Xxsctest

* Good for user testing; automatically expires after 1 day
— allxsc

* Where you can write city and jurisdiction notes

* Notices posted here automatically expire after 8 days

65

General Bulletins Overview
Bulletins
o Bulletins are messages that are intended for broad readership
e Bulletins content varies from amber alerts and earthquake
reports to jokes and recipes
e Bulletin sender controls how widely the bulletin is distributed
— Can be as narrow as “local” (this BBS only)
— Can be as wide as “ww” (worldwide)!
* In JNOS, bulletins are sorted into shared areas (mailboxes) for
easier reading

66
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General Bulletins - Why Do They Matter?

Bulletins

e Standard way to distribute information between BBSs of all
types throughout the world

e Use them for fun or for emergency communications

e Use them for distributing information to broader areas:
— Santa Clara County
— San Francisco Bay area

— Northern California
— All California
— And wider ...

e Example:

— During the 2009 cable cut, information about anticipated service
restoration times were distributed via bulletins by a ham who had
information from the telecom carrier

Copyright 2011-2023 Santa iara County ARESEIRACES. Al fghts reserves
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General Bulletin Addresses
Bulletins

e Address format: category@distribution
¢ Distribution

— Asix-character or shorter keyword which defines how widely the bulletin
will be distributed

— Sender picks from a pre-defined list

— Acceptable distributions:
e local Local BBS only
e xsc  XSC Operational Area (Santa Clara County)
e bay San Francisco and Monterey Bay area
e nca No. California (generally north of the Tahachapi Mountains)
°ca California

e wusa Western USA (generally, West of the Mississippi River)
e usa United States of America
e noam North America (Canada, USA, Mexico, ...)

e ww worldwide

Copyright 2011-2023 Santa Clara County ARESBIRACES. Al rights reserved 68
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General Bulletin Addresses (continued)
Bulletins

e Address format: category@distribution
e Category:
— Asix-character or shorter description of the main topic of the bulletin.
— Sender picks the category based on the contents of the bulletin
— Example categories:
* amber — Amber alerts
¢ equake — Earthquake reports
¢ flood — Flood reports
* swpc — Space Weather Prediction Center
¢ mty, cup, sjc, etc. — City bulletins
e humor or humour — Jokes, stories, etc.
— Any category works on our SCCo BBSs because we sort bulletins by
distribution, not category
— Uncommon/unusual categories may be held on other BBSs until the
sysop decides where it should go

opyright 2011-2023 Santa Clara County ARESBIRACES. Al rights reserved, 69
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General Bulletin Addresses (continued)
Bulletins

e Example bulletin addresses:
— mtv@xsc
* City of Mountain View information for distribution to all BBSs in
Santa Clara County
— flood@bay
* Information about flooding for distribution to all BBSs in the San
Francisco and Monterey Bay areas
— equake@nca
* Information about an earthquake for distribution to all BBSs in
Northern California
— swpc@ww
* Space Weather Prediction Center reports for distribution to all
BBSs worldwide
— humour@ww
* Variety of jokes and funny stories

Copyright 2011-2023 Santa iara County ARESEIRACES. Al fghts reserves
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Reading General Bulletins
Bulletins

e Use a terminal program like PuTTY
— Read only the bulletins of interest
— Be selective when listing and reading

e Read bulletins just like mail
— Find out what areas are available
* AREA
— Select a bulletin area
* AREA <area_name>
— List bulletins
. LA (list all)
* L> <category_name> (where category_name matches the
messages’ To: field, ex: equake )
— Read a bulletin
* R#

Copyright 2011-2023 Santa Ciara Courty ARESEIRACES. Al fghts reserve
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General Bulletin Example
Bulletins
1. Use “A” to change
area to “allww”
. Wow, that’s a lot!
. Set page length
XM 24

List All mou e sizE sumgmcr

w N

o »

. JNOS pauses

— <Enter> to continue

- <N>tostop

* Note, there are multiple,
categories in the list
— wp
- tech
- swpc
— equake

72
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Filter the General Bulletins
Bulletins

e JNOS command L> will filter the list by To: address
— Example: L>category

— ... will list only bulletins where the To: address contains category

e Example: list all earthquake bulletins

st. ¢ TO FROM DATE  SIZE SUBJECT

N 7 equake@ww  cx2sa  Mar 14 1967 SOUTHWEST OF AFRICA
N 19 equake@ww  cx2sa  Mar 15 1838 STRAIT OF GISRALTAR
N 47 equake@ww  cx2sa  Mar 16 1967 PULAU-PULAU SANGIHE, INDONESTA
N 96 equake@ww  cx2sa  Mar 18 1942 SANTA CRUZ ISLANDS
N 109 equake@ww  cx2sa  Mar 19 1990 ANDREANOF ISLANDS, ALEUTIAN IS., AL
N 114 equakefww  cx2sa  Mar 19 2015 ANTIGUA AND SARSUDA REG, LEEWARD IS
N 148 equake@ww  cx2sa  Mar 20 2007 NEAR THE EAST COAST OF KAMCHATKA, R |
(#1) > 0o
Copyright 2011:2023 Santa Clara County ARESBIRACES. Al rights reserved 73
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Read General Bulletins Like Messages
Bulletins e

#1) > ) B
> equake

e Read using  [aisow,,
theR#
ommand

FROM  DATE  SIZE SUBJECT

STRAIT OF GISRALTAR

0 SANGIHE, INDONESIA

LaNDS

F ISLANDS, ALEUTIAN IS., AL
ANTIGUA AND BARBUDA REG, LEEWARD IS

Maz 20 2007 NEAR THE EAST CORST OF KAMCHATEA, R

Pacn: NeRME!CK25A

[From: CX2SAGCX2SA.SAL.URY.S0RM
Iro + EquAREGwW

== PRELTMINARY EARTHQUAKE REPORT ==
SANTA CRUZ ISLANDS

ic coordinaces: 12.4875, 166.531%
o 5.5

Jon 1 Time (UTC): 18 mar 2016 12
Tine near the Epicenter: 18 Mar 2016 1

Location with respect to neazby cities:
185 km (117 mi) N of Sola, Vanuatu
343 km (212 ma) WWW of Luganville, Vanuatw

(378 mi) MWW of Port-vila, Vamuats
794 s (492 ma) ESE of Honiaza, Solomon Islands
hore (v=m0) 2 | B

i rights reserved 74
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But, what about PackltForms?

Copyright 2011-2023 Santa Cira County ARESBIRACES. Al rghts reserve 77
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Submitted for your approval... PAT

Packet Operator. This is great... Your first MAC assignment!

e Asyou enter, the last shift Packet Op rushes past you saying...

“there’s a couple of ICS 213’s on the desk to be sent!”
e At least you won’t be bored.

e Over your shoulder, you hear him yell back...
“Oh yeah, | could never get Outpost to work after IT
updated the Windows O/S... and they just left.”

e The PCis running; you click the Outpost icon... Error; and you
have never seen this error before ®

e OK, deep breaths. You know what to do, right?

He
e
e You just arrived at XND Fire Station 14 to take over as

&

10/19/2023
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Manual PackltForms

Fortunately, PackltForms is a message creation system designed
to work with both Outpost or as a standalone solution for forms-
based messages.

¢ What’s new with the PackltForms 3.10
— Enhanced standalone message management, including:
— Manages setting up and using user and tactical IDs
— Takes care of message numbering
— Includes a Plain Text message form
— Creates a standalone 1CS-309 log
— Creates copy-ready text (all BBS commands) to paste into PuTTY
— Easy message saving
e What’s the same
— Tight integration with Outpost
— Supports all PackltForms
— Formats a standard packet form for sending
— Processes a received packet form

79

Get ready for Manual PackltForms

Things to do before you get started:

1.
2.

Create a directory where you will save your messages.

Consider a naming convention that is relevant for your assignment,
examples:

C:\MyMessages\X14-23-1009T (by Activation Number)
C:\PacketMessages\2023-10-09 (by date)
C:\Xanadu_Station_14 (by assignment)

Identify a starting message number

— Can be any number; PackItForm will append a M for Manual to make
it unique.

MyActvations

Myhddons

Logs
MyMessages Mise

X14-23-10097

i A TGO e

80
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Manual PackltForm messages

Manually create a PackltForm message
Run PackltForms with the manual.cmd
Set up your user ID, tactical ID, and Next message number
Pick and fill in a PackItForm

1.

2

3

4. Create the packet message

5. Send the message with PuTTY
6

Save a copy of the message

Copyright 2011-2023 Santa iara County ARESEIRACES. Al fghts reserves
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1. Running manual PackltForms

1. Open your File Explorer and navigate to
C:\PackItForms\Outpost\SCCo

2. Find the file manual.cmd, and run it (double-click on it)

Ll o st v [

= v 1 1« Windows (C) > PackitForms > Outpost > SCCo

CoverSheet Gl Name
Report91 addons
logs pdf
pack-it-forms saved
Perflogs B UserGuidehtmi

Program Files (x86)

12 H=

Copyright 2011-2023 Santa Clra Couty ARESEIRACES. Al fghts reserve
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2. Set up manual PackltForm

Ble Edn Yiew Wigioy Bookmans Iools Help

B

Setup Page 1
@ scco Packnforms % Sewp Pacitforms % | 1210015487

The setup page loads when you ;)
first start. C @ O Doorswrmn s & @ I §
b

3. Fill in or update all fields: Santa Clara County ARES/RACES PackltForms d
— Your user information User Call Sign: wexLa 2

. . . i

— Tactical Call information e 4

ge ID Prefix: pq max) 4

— Next Message Number §
_— |

. Use Tactical Call Sign f

fYI... Usgr andATactlc?I Call L ——y )
information will persist from R e weccion 1¢ 4
run to run. Message IDPrefix: x1a (3 characters max) 3
FYI... The Next Message Number ]
will increment automatically. e e Concel 3

4. Press OK when done

B T SEE e

opyright 2011.2023 Santa Cira County ARESSIRACES. Al rights roserved

83

© Copyright 2011-2023 Santa Clara County ARES®/RACES. All rights reserved.

27



Packet Operator Type Il

3. Pick and fill in a form

e o iy oS T
Home Page

Home Pa e @ | 5CCoPackitFomms x| +
Consists of 2 sections and a ¢ 5 G 0D wasmm

series of controls:
e Setup button: Opens the

sl wr @B e =

Santa Clara County ARESIRACES PackitForms PIF:21

Setup page. “Creats a mossage o send
Wessage type:
Edit ICS-309 Log: lets you

Creata essage
make updates to the

S recaed message

manual ICS-309 Log.

upload a fle.

Ener the received message, Inciucing the From, Subject and other headers. You can paste,drag and arop or

Message: [

¢ Create a message to send
Choose a PackltForm
message, then press
Create Message

Uploas

Downlosd

¢ View a received message.

Paste in a received
message, then press

Logand View  Reset Feds

e e e

Log and View

10/19/2023
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3. Pick and fill in a form
Home Page . =
5. From the dropdown 5 o =
menu, select a PackitForm, ~ Stmaclenc =
=)

plain text m"’;‘:""""
XSC I5-213 Message

XSC EOC-213RR Resource Request
XSC 0A Jurisdiction Status
XSC 0A Shelter Status

Xsc Allied Health Facility status

L LT

XSC RACES Mutual Aid Request

XSC Check-In/Out Message »r.\\\r!&t\«a\qtﬁ v

: a
(2enror (TR e e e

[
L)

MESSAGE FORM  cugmsugs: e g
then: sccscsmmrons e an
: o Tasgen 1 | Hemding * {0 trvpeston poen O Poey i O seyies o
6. Press Create Message oo TH I ittt T "
i o, veny -
The PackItForm opens with 18 passson: [ J15 weromen: | |
the usual fields filled in. < . :
Telephone #: Telophons &
Sutgect: | |
i T P —

85

3. Pick and fill in a form

Creating a message
On the selected PackltForm,
7. Fillin the form as usual.

NOTE: The Message ID is set

with the M suffix;

Origin Msg #: °
X14-312M

PacklItForms takes care of this

for you. Hlmens

8. When done, press

Create Message R
s
R TS
v O
Was ISR G

86
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4. Create the packet message

Message Page
On the Message Page,
9. If needed, check the box if

Bookmats Toos Hew

c @ Q D 4
this message is Urgent (I or A
a Bulletin 0. Urgent: 1 Buletin: [
10. In the To: field, =T Ead s

o Subject: X1a-312M_R_TCS213_Equipment Status
* enter the Destination

address Message: Isccopzrol
" #T: form-1cs213.html
* multiple addresses, Wi 3.11-2.2

separate with commas. gl il
0116
11. When done, press \ s mnml;
Log and Send Log and Send

8 P P i et s . o B B

x| wiazam RS2t Equpment st x|+

il e

SR A STV

10/19/2023
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4. Create the packet message

Tile £t Yew Higtory Bookmars Iook Help

BBS Command Page
The complete packet-ready text

SCCo Packitiorms X | 12700164874 e 241X 143123

is ready for sending. 5 ¢ e RiGhzie
12. Copy the text. Put your ThoSIn et Eavirsant Status
mouse cursor in the text s I
area, and then either: e Taai
— From the browser menu, ot ookl
Edit > Select All fuogistite]
Edit > Copy anda e )
.+ [Xanadu Fire Station 14]
~-orenter - L eonant e resdy for deplyment. |
— <ctrl>-a <ctrl>-c i alaanar]
(same as the menus) e ey ]

Other: [Packet]
opoate: [10/09/2023]
OpTime: [20:17]
1/ADDON]

Reminder: PackltForm creates
a properly formatted Subject
line... do not change this!

ght 2011-2023 Santa Clara County ARESIRACES. Al rights re

JEx

o P Bt b i, . gt N

x

{
R b s i s A Ay e AT

e

88

5. Send the message

What are the Steps?

13. Make sure you previously copied the packet message from the
BBS Command Page (previous page)

14. Start PuTTY
15. Connect to the BBS

16. Once at the BBS prompt:
— Put the cursor in the PuTTY text area after the BBS prompt, and then
— Mouse right-click to paste in the message.

The complete packet-ready text is pasted into PuTTY and will start being
transmitted to the BBS.

Reminder:
All SCCo BBSs have a 2-minute inactivity timer!

89
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5. Send the message
BBS Command Page

Ele Edt View Higoy Bookmeds ools Help

[
@ | sccopktorms X | 0sveeTsey
€ C @ O D 2roorsan

SP XNDEOC@W1XSC . ampr. O
X14-312M_R_ICS213_Equipment Status
IsccopT
#T: form-ics213.htal
w: 3.11-2.2
Msgho: [X14-312M]
1a.: [10/09/2023]

[Logistics]

[station caption]

[Xanadu E0C

9b.: [Xanadu Fire Station 14]
10.: [Equipment status]

12.: [All equipment is ready for deployment.]
Rec-Sent: [sender]

opcall: [WexaLa]

Optiase: [Herman Munster]
Hethod: [Other]

other: [Packet]

S t:p..&_,-..*....‘
¥

PuTTY Screen

(#1) >
ISP XNDEOCGWIXSC ampr . or
1X14-312_R_ICS213_Equipment Status
|1sccopFO!

[#T: form-ics213.htm]

1#v: 3.11-2.2

IMsgNo: [x14-312m]

'a.: [10/09/2023]

11b.: [20:16.

15.: [ROUTINE]

17.: [Logistics]

18.: [station captain]

19a.: [xanadu EOC]

19b.: [Xanadu Fire Station 14]
110.: [Equipment Status]

: [A11 equipment is ready for deployment]
IRec-Sent: [sender]

lopcall: [W6XRL4]

|OpName: [Herman Munster]

{Method: [Other]

(0ther: [packet]

1oppate: [10/09/2023]

lopTime: [20:17]

!/ADDON!

10/19/2023

Opbate: [10/@9/2023] ToT XNDEGC@WIXSC.ampr.org
OpTime: [20:17] Subject:
F/AoDON! Enter message. End with /EX or Az in first
fEX column (AA aborts)
- Msg Queued
P e S D) >
yright 2011-2023 Santa Clara County ARESE/RACES. Al rights re d =0
6. Save the message
Ele Edt Yiew Higtoy Bookmarks Jools Help 3
BBS Command Page P — « [CTTETTE———
. L

Back at this page, o o 6 Olorras : :

17. Put your mouse cursor in the P 1
text area, and then: X14-3124 R IC5213 Equipment Status 1

’ 15CCOPTFO! 3
— From the browser menu, o5 T led o ’
File > Save As S abreora003] 3
--or-- bt it i
— <ctrl>-s (same as menu) ot [EtEeion Caption 1
9a.: [Xanadu EOC] -
b.: [Xanadu Fire Station 14] i
[Equipment Status 1

. 11 i i dy Fe 1 .

18. If not shown, navigate to the  ne'siat: [remery = "o for deployment.] 1
PackltForm save directory g;’:ﬂi {»w::::]nunster] )
previously created. :i::??'[L?EE:C] 1

. Opbate: [10/09/2023] i
PacklItForm sets the file by Hns Rt & ¢
name to the listed subject. /& ;

19. Press Save. i & i A e
yright 2011-2023 Santa Clara County ARESE/RACES. Al rights re d 91

A note on manual plain text messages

* Yes, PackltForms does support manual Plain Text message
sending and receiving. T T e T e T B )

¢ After picking plain text message ® | G oeoge X FCKSIMMemsge X SCloRiors X

from the Home Page, the O Oliinis vos 4
Message Page opens up. 1
. urgent: [ Bulletin: [ i

e Message ID and Handling order = T -
are filled in, DO NOT REPLACE THIS!  gupect: wag-1254 8 caupment states

e Fillin... ‘
— To: destination packet address
- the rest of the Subject text H
— Your plain text message i
. ST i

e Finally, press Log and Send - ]

¢ The rest of the send process is the {

same. i
e et el ettt )

92
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Manual PackltForm messages

Receiving messages
1. Read messages from the BBS using PuTTY
2. Save the message

3. Once you have the message saved, delete the message off
of the BBS (use the Kill # command)

10/19/2023

Note: All SCCo BBSs have a
2-minute inactivity timer!

93

PuTTY Screen

#1) >
r1

te: Mon, 9 Oct 2023 20:26:
: xndx14@wlxsc.ampr.org

To: xndeoc@wlxsc

subject: X14-312M_R_ICS213_Equipment Status

1SCCOPTFO!
#T: form-ics213.html
#v: 3.11-2.2

MsgNo: [x14-312m]
la.: [10/09/2023]
1 :16]

5.: [ROUTINE]

Receive manual messages

PackltForm Home Page

5

A

/]

i

H

{

Create a messags to sena i
Message type: xsc 165213 Message v: {
1

View a received message L

Enter ihe received messags, Incucing the From, Subject and oiher hoadel

7.: [Logistics] 1
8.: [station captain] SN e S or e A 1
+: [xanadu EOC]
[xanadu Fire Station 14] )
[Equipment status] '
[A11 equipment is ready for deployment] A
nt: [sender] 3
opcall: [W6XRL4]
OpName: [Herman Munster]
method: [other]
Other: [Packet]
oppate: [10/09/2023]
opTime: [20:17]
1 /ADDON!
@D > Received Date: ja/e9/2023 Time: 3o.41 7
Log and View Reset Fiekds -3
1. Receive a packet message
(#1) >
rl

Suppose at XNDEOC... Outpost
shows the same error.
1. Connect to the BBS with PuTTY
and retrieve a message
2. List the messages with LM
3. Read the message with
R # (message number)
You recognize Message #1 is a
PackltForm message
4. Highlight all text from
Date: to !/ADDON! (inclusive)
— In PuTTY, selecting text copies
it to the clipboard

10a on, 9 oct 2023 2 S17PST

1From: xndx14@wlxsc.ampr.org

1To: xndeoc@wlxsc

|subject: X14-312M_R_IC5213_Equipment status

1 15ccopIFo!

1#T7: form-ics213. html

1#v: 3.11-2.2

IMsgNo: [x14-312m]

11a.: [10/09/2023]

1 [20:16]

[ROUTINE]

[Logistics]

[station Captain]

. [xanadu EOC]

.: [xanadu Fire station 14]
.: [Equipment status]

. [A11 equipment is ready for deployment]
IRec-sent: [sender]

W6XRLA]

Herman Munster]
other]

NOTE: This manual process handles
both PackitForms and plain text
messages. Both can be processed by
pasting them into the Home Page.

loppate: [10/09/2023]
jopTime: [20:17]
| 1/ADDON!

‘g 2011-2023 Santa Clara County ARESBIRACES. Al rights
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Home Page

Back at the Browser, get back to the
SCCo PackltForms tab

5. Putyour cursor in the “View a
received message” section, and
enter <ctrl>V or Edit > Paste to

2. Recover the PackltForm message

fle it View Hgory Bookmars. Tools Help
@ | sCComasrom X | XMINMRICS203 Equipmen S X

< C 0 O D wossw s % O
G I UL P I TSR S

Setup | Edit 15309 Log

Create s message to send F
Message type: XsC IC5-213 Message ~

Creatn Message F

10/19/2023

View a recelved message

drag and drop ar upioad a fie.

paste in the received message. Enter e rsived message, s e From, Subectand vl heade]

9

Xanadu EOC |

t
6. Press Log and View. Upkosd {
— This entry is logged to the ICS 309 Download :
— The received PackltForm is opened in {
its PackItForm. 1
7. Once the PackItForm is opened, ':
print and hand it off for delivery. B!
Received Date: 10/09/2023 TIME: 20:41 ¥
Log and View Reset Fields 3
yigh 2011:2023 Sana Ciara Coury ARESSIRACES. Al s o 3
.

3. Save this PackltForm message
8. Back at the Home Page, the Edt iew bigory Eockmaia Tools telp 2
5
Press the Download button. @ | sccomasroens | XIS Eapment Sl X 'J
The Message Page opens an, ’ & 0 DD e o 2y o)
shows the message text. A I VU FUTI F aLA S :
9. Put your mouse cursor in the S2tup i ICE000 109
text area, and then: CSa X Tias R 15 W i
Me: ; = - i
— From the browser menu, SEEE P P I 3
File > Save As - {
-—-or - View a recelved message .
Enter the recelved message, including the From, Subject and oiher headel
— <ctrl>-s (same as menu) drag and drop o upioad a fle. 1

10. Navigate to the PackltForm
save directory previously
created. The file name is set
to the Subject.

11.Press Save.

Received Date: 10/09/2023 Time: ze:a1

Logand View  Resct Fields

97

Sidebar: A Note on Outpost tags

* Messages sent from Outpost occasionally have “tags”
inserted in messages that you might see.
e Some of the more common tags are:
— IRRR! Request Read Receipt
— IRDR! Request Delivery Receipt
— ISCCoPIFO! This is a PackltForm message
— 1/ADDON! The end of a PackltForm or other Addon message
— IUG! Mark message as urgent (lists as RED in the Outpost listing)

e PackltForms will ignore many Outpost tags that it sees and
they will not show up in the message.

98
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What about the saved messages?

Take a look at your C:\MyMessage\X14-23-1009T\ manual message
directory (or whatever you named it).

The message’s Subject field is used for the file name.

Clicking on the “Name” column header sorts messages by file name.

Clicking on the “Date Modified” column header sorts by file timestamp.

These views can help with managing your messages.

Submit this
directory with

Home  Stare  Vew

your paperwork t This PC > Windows (C) > MyMessages > X14-23-1009T v O
when done. MyActhations & Name it modife
Mnden EOC-1245P_R_Report Station_Staff Status.txt 10/9/2023 9:42 AM
MyMessoges X14-310M_R_Check-In XNDO014, Fire Station 14.txt 10/9/2023 9:20 AM
Logs X14312M_R_ICS213_Equipment Satus.xt 10012023 9:55 A
M X14317M_R_ICS213_72 hourstaffing plan.tx 10192023 10:15 AM
R X14319M R_EOC213RR Xanadu Complex Fire.bt 10192023 11:02 AM
evasy X14321M R _Surprise Pizza 101912023 223 P
iy X14-325M_R_Check-Out XNDO1, Fire Staton 1450 10192023 4:12 P
yright 2011-2023 Santa Clara County ARI right 99
What about the ICS 309?
¢ Manual PackltForms comes with its own ICS 309 Log, similar to what
Outpost does.
* From the PackltForm Home Page, when you click on Log and View ,
you write a new ICS 309 Log entry for this message.
¢ From the PackItForm Home Page, when you click on | Edit ICS-309 Log |,
you open the ICS 309 form for editing and printing.
1 Coa Gounty ARESDIRACES. Al g 100
What about the ICS 309?
e R
o All fields are editable. - ) e
a w2001 v fr © b
¢ Required fields are -
CONM Log " Foamtie o 15 =

highlighted in RED. 105 309-56C0

Trash Can symbol deletes 3 Rsda i l .
the entry.

Plus symbol adds another
line for a manual entry.
Erase All - clears the
form, does not require a
Save to commit the
changes.

Download... - creates a

.csv file of the Comm Log. [ ™ ymmosei
N . (09:24  |oweis K141 OEOCEML (W_Check-Out XMD#14, Fir
Print — prints the Comm los:37  |xndeoc  toc-zese |moguac k_Report Station/staff

n_check-1n o002, Kiss
xazaam  |ooeocha R_ics313_opening status

xaz-1am  |ooeocea

Log to the selected ke
printer. ‘ If) o
¢ Save — Saves any changes
1033005000 ARESRACES (Rev. 2021 [Ezasaiil] = =
you made. A8

101
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Manual packet operations; not many changes
This is a tool change, not a process change

1. First Shift...
a. Show up, request a safety and assignment briefing
b. Find a workspace for your packet operations
2. Initial station setup...
a. Find, assess, and set up the packet station
b. equipment check-out
3. Packet Operations...
a. Download notices, send yourself a test message
b. Send the formatted check-in message with your Tac Call
c. Manage the message flow
4. Incoming Shift Change...
a. Request a safety and assignment briefing
5. Outgoing Shift Change...
a. Archive the event documentation
6. Securing Operations...
a. Send the formatted check-out message with your Tac Call
b. Archive the event documentation
¢, Shutdown

102

10/19/2023
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Amateur Packet Radio
Field Reference, Type Il

e Taking a quick look inside

(the unofficial)
Amateur Packet Radio
Field Reference, Type I

Table of Contents
1  QUICK REFERENCE.....
2 INTRODUCTION November 2023
21 Puspose i
22 HOW TO USE THIS HANDBOOK
23 OTHER REFERENCES ...ovecusnninenin
MANUAL PACKET OPERATIONS
31 TNCComMmANDS..
32 BBS CommanDs... 5 i
33 Connecting TO THE TNC wimi PUTTY L.
34 START OF SHIFT: ConriGURE TNC SETTINGS .
35 END OF SHIFT: RESTORE TN%SErwos
36 GETTING READY FOR MANUAL MESSAGING
37 MANUAL MESSAGE BASICS .....oo.ooeocein
3.8 S5eNDING A PACKITFORM MESSAGE MANUALLY.
39 Receving A PACKITFORM MESSAGE MANUALL
310 VIEWING SAVED MESSAGES ........oieuoeisceioeanecin
3.11 Noreson ManuaL ICS 309 Comm LoG ...

For SCCo RACES Responders

@

@

bt

e et b o s

103
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Could manual packet ops really happen to me?

* Better to be safe than sorry... Build your USB packet
thumb-drive now!

T
o
Directories (suggested) —
— x:\Programs
Putty installer (https://www.putty.org/)
Putty (https://www.putty.org/ > Alternative binary files)
SCCo PackltForm Directory (C:\PackltForms\Outpost\SCCo)
SCCo Packet Installer - https://www.scc-ares-races.org/data/packet/client-software.html
SCCo PIFO only Installer (<download_dir>\sccsetup162Mpub_includes\SccoPIFOsetup3.13pub.exe)
Office Libre Portable version (https://www.libreoffice.org/download/portable-versions/)
— x:\SCC Notices

+ downloaded text version

* Archive of the Outpost SCC Notices directory to reload if necessary
— x:\TNC Init files

* text version, seven total
- x:\Docs

« Toomany to list here... (https://www.scc-ares-races.org/data/packet/index.html)

* Unofficial Amateur Packet Radio Field References, Type IlI, Type Il e-book edition
— x:\Miscellaneous

* Pre-defined messages to be edited prior to sending
- x:\MyMessages\<event>

« Orwhatever directory name you choose.

23 Santa Ciara County ARESEIRACES. Al fght
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Questions?

105

WRAP UP

1t 20112023 Sarta Clara County ARESEIRACES. Al ights reserved 106

106

First things first

e Online Class Evaluation

— Log into https://www.scc-ares-races.org/activities/events.php
Click “Submit Class Evaluation” in Events

Home | I i
Loa Out of Events E
Activitles Home Show: Current events @ Past events Event Descriptions {
SCC ARES/RACES Home |
: Packet - Type II - Ady / Ti {
Events Datc Stan: Tyie Credential of
List Events By Date : M i e |
List Events | loined Course Detalls: Click here to visit the course description and download the ¢
Create o New Event ele... \
Modiy an Event {
Delate an Event [y Z & 1
/AEC Council Meetin: ]
List/Print an Event Rostec EL . 4
Date Stont: Type: Credential
Log Event Participation o e 1
Submit Class Evaluatio 3
- Purpose: Discuss organizational and management ideas, strategles, best pre
Ny o e e it i s

— Submit your evaluation as soon as possible... after 1 week, the form
will no longer be available for this class!

oputaht 2011:2023 Sarta Clra County ARESSIRACES. Al rigts reserved 107
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Exercise Scenario

* You've been dispatched by the Xanadu EOC to provide
communications for a field location.
— The EOC’s tactical call is XNDEOC on W1XSC.
— Your tactical call is: XND### (Assigned by your instructor)

— Your Message Prefix: X## Where “##" are the last two
. digits of your tactical call
— Your assighment Name: Xanadu Post ##

— Operate using your home city’s primary or secondary BBS.

e You arrive at your assignment and set up the station, but
discover that Outpost on the packet PC does not work! Looks
like you need to do all packet operations manually.

* Your assignment will be mailed to you ahead of time.

1t 2011.2023 Saria Clara Counly ARESEIRACES. Al righis reserved 108
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Thank You!

Please complete the Course Evaluation
on or before next Saturday 11-November!

Please complete the Assignment
on or before next Saturday 11-November!

Office Hours:
Sunday, 5November, 3:00p to 5:00p (zoom)
Wednesday, 8-November, 7:30p to 9:00p (zoom)

If you have questions or feedback about this or other training activities,
you can join our packet discussion group.
https://scc-ares-races.groups.io/g/packet

Questions, comments, suggestions?
knépe@arrl.net

© Copyright 2011-2023 Santa Clara County ARES®/RACES. Al rights reserved 109
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